PROCEDIMENTOS PARA DIGITALIZAGAO DE EXSICATAS

(Silverimage Copy Station)

PASSO 1 - SEPARAGAO DO MATERIAL PARA DIGITALIZAGAO

Buscar as plantas nos armarios seguindo a ordem de organizagcao do herbario.

Sinalizar com um papel o ultimo escaninho de onde foi retirado material, indicando quais serao
os préximos a serem fotografados.

Apds fotografar o material, guarda-lo no mesmo lugar e ordem que foi retirado. (Sempre

verifique e revise a ordem dos materiais nos armarios!)

PASSO 2 - LIGANDO O EQUIPAMENTO

Ligar o monitor. (O computador sempre estard ligado, apenas o monitor fica desligado!)
Ligar as luzes da estacao.

Ligar a camera e tirar a tampa da lente.

PASSO 3 — ABRINDO OS PROGRAMAS (EOS UTILITY/SILVERIMAGE)

Clicar no icone do programa EOS Utility (Fig. 1) na Area de Trabalho. Ird aparecer uma primeira
janela (Fig. 2). Clicar em “Camera settings/remote shooting” e aparecerd uma nova janela do
EOS Utility (Fig. 3). Configure os elementos da cdmera mostrados nessa janela: pasta
“Incoming”; 1SO 200; Velocidade obturador 1/30 (ou 1/25); F8.0 (9 a 10); Auto-foco (AF);
formato RAW; Picture Style (Standard); Detail set. (7, 3, 0, 0).

Cligue em “Lens aberration correction” e selecione a lente EF50mm f/1.4 USM (Fig. 4).
Verifique também na lente da cdmera se o foco esta posicionado em AF (Fig. 5).

Clique no icone do Silverimage (Fig. 1, desenho de duas engrenagens) que estad na Area de
Trabalho. Abrira uma janela preta de comandos (formato DOS). (O Silverimage s abre se essa
janela de comandos estiver aberta!)

Entre no Mozilla Firefox e clique no icone Silverimage na barra de favoritos. Faga o login e
abra o File = Open Project = [nome do projeto = nome do herbario] (Fig. 6).

Obs. 1: Para criar um novo projeto deve seguir o caminho File > New Project (Fig. 6) e nomear

0 novo projeto (Fig. 7).



Obs. 2: Para criar novo login clique no icone do menininho no canto inferior direito (Fig. 8). Vai
abrir uma nova aba (Fig. 9). Clique em “Settings” e depois em “User Manager”. Depois, para
adicionar novo login clique em “Add”, preencha os campos com o nome, login e senha e clique

em “Save” (Fig. 9).
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Figura 1. icones do Digital Photo Professional, EOS Utility e Silverimage.
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Figura 2. Janela inicial do EOS Utility.
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Figura 5. Botdo de AutoFocus (AF) na lente.
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Figura 7. Criando Novo Projeto no Silverimage.
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PASSO 4 - CONFIGURAGOES

Configuragao do EOS Utility

Configuragdo do foco e balanco do branco (White Balance): Posicione a exsicata alinhada com
o gabarito colado na mesa da estacdo. Na janela do EOS Utility (Fig. 3) clique em “Live View
shoot” (Fig. 10) e faca a regulagem: clique “on” no campo “Focus”; clique “on” no “Deep-of-
Field Preview”; faca o balanceamento do branco (va em “White balance” clique no conta-
gotas e arraste-o até a barra branca da cartela de cores colada na mesa da estacdo). Feche o

“Live View shoot”, dispare uma foto e verifique a luz e o foco da imagem.
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Figura 10. Janela do “Live View Shooting” (acionada a partir do EOS Utility).

2. Configuracdo do Silverimage
Primeiramente crie uma pasta no diretério C:\ e nomeie com o nome do herbario (Ex.
HERBARIO images). Dentro dessa pasta crie 4 pastas: incoming, batch, session e output (Fig.
11).
No Silverlmage, faca login e entre no projeto criado. Depois cliqgue em “Tools”, depois em
“Project Settings” (Fig. 12) e preencha os campos (Fig. 13): insira o acronimo do herbario em

e,

“Project Name” e “Barcode Prefix” (somente se o cédigo de barras da colegdo ndo contiver o
acrénimo inserido antes dos numeros, Ex. ABCO0O0001); e copie e cole os links das pastas

Incoming, Session, Batch e Output como mostrados na figura.

@Ov‘ | » Computador >|OS (C:)' jbrj-images »
Organizar ~ Incluir na biblioteca ~ Compartilhar com = Gravar Nova pasta
&
> | 2e07960cbe3904745fd429505e269f = Nome Data de modificac..  Tipo Tal
I 7c60cfa2ec2c86bl7dedbdfece
30/03/2016 13:05 Pasta de arquivos
| 373471c78e3580ch6c5fea740021a903
5 I camera 12/03/2012 14:17 Pasta de arquivos
> | Arquivos de Programas
) | duplicates 05/03/2012 15:56 Pasta de arquivos
> | Arquivos de Programas (x86)
31/10/2014 13:58 Pasta de arquivos
> | c6004e65bca7079fe249529f66f2e2 ~
I output I 28/03/2016 13:54 Pasta de arquivos
| d9af7el6cfod9798blab
dell ! output_11032016 26/02/2016 13:27 Pasta de arquivos
> b del
3 I output_11122015 07/12/2015 13:02 Pasta de arquivos
> L. Drivers
I output_15012016 08/01/2016 13:11 Pasta de arquivos
| e7668baec/05dce9415448eded2ac34t
. . . I output_15012016(1) 15/01/2016 15:42 Pasta de arquivos
> L. HP Universal Print Driver
— I output_15012016(2) 15/01/2016 16:02 Pasta de arquivos
4 | jbrj-images _
p— I output_17122015 14/12/2015 13:08 Pasta de arquivos
| batc
I output_17122015(1) 17/12/2015 13:03 Pasta de arquivos
| camera
. | output_18032016 11/03/2016 13:25 Pasta de arquivos
| duplicates -
. . 3 | output_23032016 23/03/2016 07:40 Pasta de arquivos
> | incoming
tout | output 26022016 19/01/2016 13:01 Pasta de arquivos
> | outpu
| session 30/03/2016 13:53 Pasta de arquivos
> | output_11032016

Figura 11. Pastas (Incoming, Session, Batch, Output) dentro do diretério C:\HERBARIOimages.
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Figura 12. Project Settings (configuragdes) no Silverlmage.

Project Settings ®

General Image Server Barcode Configuration

Project Name: | ACRONIMO DO HERBARIO
Project Identifier:
Barcode Validator: |a regular expression (leaving blank accepts anything), ie. NLU[0-9]{7}%
Postfix Separator: _
Postfic ASCIT Key: 0
Barcode Preftx: | ACRONIMO DO HERBARIO
Overwrite Prefoc [

Incoming Extension: CR2

Qutput Extension: |IPG

Incoming Path: | C:\HERBARIO images\incoming\,

Batch Path: [ C:\HERBARIO images\batch\

|
Session Path: IC:\HERBARIOimages\session\ |
|
|

Output Path: |C:\HERBARIO images\output\

Total Images: | Estimate the total number of images to scan (ie. 10500).

Enable Queue Manager: []

o] Save Cancel

Figura 13. Project Settings (janela de configuragdes do Silverimage).

PASSO 5 — DIGITALIZAGAO DAS EXSICATAS: FOTOGRAFANDO

1. Posicionar as exsicatas na mesa com as partes inferior e lateral sempre encaixadas no gabarito
da mesa.

2. Se necessdrio, limpar eventuais “sujeiras” (terra, poeira etc) com auxilio de um pincel (com
cuidado!).

3. Se a exsicata contiver envelope sempre verificar o contetdo (flores, frutos, fragmentos da

planta), retird-lo e arruma-lo sobre a exsicata (ou sobre o envelope fechado) para que apareca



na foto. (Se necessario, pode-se usar uma pequena cartolina branca para arrumar o contetudo
do envelope).

Verificar se a exsicata possui cédigo de barras e se esse esta visivel.

Verificar se os dados da etiqueta estdo visiveis.

Escolher o lugar ideal para posicionar a régua. Esta deverd permanecer preferencialmente na
posicdo vertical, na margem esquerda ou direita medianas e com o logotipo do herbario na
mesma posicdo de leitura que as demais etiquetas da exsicata (ou fixe a régua na barra lateral
junto a cartela de cores).

Dispare a foto (com auxilio do disparador). Automaticamente aparecera a imagem registrada
na janela “Quick Preview” (Fig. 14). Essa janela sempre exibird a foto recém-tirada. Ao mesmo
tempo, no Silverimage, aparecera uma barra verde (Fig. 15) com o nome original do arquivo
feito pela cdmera Canon (Ex. “IMG_0001.CR2”, “IMG_0002.CR2"” etc) e no Digital Photo
Professional aparecerd a imagem na pasta “Incoming” (Fig. 16).

Verifique se a imagem esta boa (posicdo na mesa, luz, foco, posicdo das escalas) e pronta para
ser renomeada com o cddigo de barras. Caso queira atestar a qualidade desta imagem, va até
a janela do Digital Photo Professional (Fig. 16) de um duplo clique no arquivo que aparecera
na pasta “Incoming”. A imagem abrird. Dé novamente um duplo clique para dar o zoom e
verificar o foco.

Obs.: Uma mensagem “Generating a high quality preview” aparecera por alguns segundos
logo abaixo da janela. A imagem focada sé aparecera quanto essa mensagem desaparecer.

(Fig. 17)

P Quick Preview | IMG_0000 CR2 ol @a]

Figura 14. Janela “Quick Preview” (pré-visualizagdo da imagem recém-tirada).
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I SilverImage x \+
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SilverImage SilverImage Manager EE Tropicos & Gmail %jabot a2l fsi & HV

File~ 1’3 Reports &) Help

Project: default
Barcode Entry: Scanner Mode Session History Issues Force Upload
|Scanner Mode = | Post Fix ;:J Auto Refresh
Barcode: |‘ | Station D Filename
1 01032455-1.CR2
1 01028281-1.CR2
Last Barcode Scanned
1 01049887-1.CR2
1 01018185-1.CR2
1 00960909-1.CR2
Statistics
1 00579168.CR2

Figura 15. Barra verde indicando imagem recém-tirada.
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Figura 16. Digital Photo Professional: pasta Incoming.
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Figura 17. Aguarde a mensagem “Generating a high quality preview...” sumir para verificar a

gualidade da imagem.

PASSO 6 - DIGITALIZACAO DAS EXSICATAS: RENOMEANDO COM O CODIGO DE BARRAS

Para que o arquivo seja renomeado com o cddigo de barras e armazenado no Silverlmage, o
campo Barcode (Fig. 18) deve estar ativado (é sé clicar sobre ele). Passe o leitor sobre o codigo
de barras e verifique se o nimero aparecera no campo Barcode (Fig. 18). Automaticamente a
imagem sera renomeada com o cddigo de barras, a barra verde ird sumir e aparecerd uma
mensagem dizendo que a imagem foi salva com sucesso (Fig. 19). Para checar se isso foi
realizado, verifique se a imagem renomeada aparece na lista a direita (Fig. 19, aba Session).
Todas as imagens renomeadas ficam registradas nessa lista.

No Digital Photo Professional, a imagem renomeada saird automaticamente da pasta
“Incoming” e ird para a pasta “Session” (Fig. 20). E na pasta Session que todas as imagens
renomeadas ficarao armazenadas! Sempre verificar se o material renomeado esta sendo
enviado para esta pasta! (Seja no Digital Photo Professional seja no C:\HERBARIO
images\session).

Obs. 1: Caso a leitura do cédigo ndo seja feita (por engano) e uma nova foto for tirada,
aparecerdo duas (ou o numero de fotos tiradas a mais) barras vermelhas abaixo de Barcode e
uma mensagem avisando que existe mais de uma foto na sessdo (Fig. 21). Nesse momento, o
bolsista deve verificar qual imagem deixou de ser renomeada com o cddigo de barras (ou se
por engano o disparador foi apertado duas ou mais vezes)!

Obs. 2: Se preferir/precisar/ou por engano fotografar novamente uma exsicata que ja

foi salva, ao passar o cddigo pelo leitor a barra piscara em vermelho e uma mensagem



aparecera avisando que essa imagem ja foi fotografada e se deseja substitui- la pela foto

recém-tirada (Fig. 22). (Além de avisar, a mensagem trard o local onde essa imagem esta

armazenada. E recomendavel ir até o local e abrir a imagem para verificar se é a mesma que

estd sendo fotografada no momento!).

O Silverimage possui 6tima memdria e grava tudo o que ja foi renomeado no

programa. Mesmo as imagens da pasta Session (ou mesmo da pasta Output) que ja foram

deletadas manualmente serao alertadas que ja foram renomeadas.

_/.‘" Silverlmage x "'\ +

€ localhost/silverimage/index.php
E] Silverimage E] Silverimage Manager EZ Tropicos & Gmail %jabot & fsi @ HV
File = ] Reports & Help
Project: default
Barcode Entry: Scanner Mode Session History Issues Force Upload

Scanner Mode » | PostFix [.:—’ Auto Refresh |

Barcode: 00789603 | Station ID e
1 00789603 CR2
1 00441538-1.CR2
1 00441538.CR2
Last Barcode Scanned
1 00384243-1.CR2
00789603 I 1 00384243.CR2
-gtat' = 1 00386871-2.CR2
i1stics
1 00386871-1.CR2
1 00386871.CR2
1 01094291.CR2
Figura 18. Cédigo de barras aparecerd no campo “Barcode” ao passar o leitor.
"’/ Silverlmage x-x'\ +
€ lacalhost/silverimage/index.php C Pesquil

B Silverlmage E Silverlmage Manager E Tropicos & Gmail %jahot & fsi @ HV

File~ ]= Reports & Help~ Processed
Project: default Specimen image added.
Barcode Entry: Scanner Mode Session History Issues Force Upload
Scanner Mode * || Post F\xl [.:—’ Auto Refresh |
Barcode: || | Station D Filename
1 00386871-2.CR2
Last Barcode Scanned 1 00386871-1.CR2
1 00386871.CR2
00384243 1 01094291.CR2
Statistics 1 01032455-1.CR2
1 00112233.CR2
1

01028281-1.CR2

Figura 19. Mensagem no Silverimage avisando que a imagem foi salva/renomeada

sucesso.

com



. Digital Photo Professional - [C\jbrj-images\session]

File Edit View Bookmark Label

Adjustment Tools Window Help

Stamp  Trimming
Angle

Rating

Arquivos de Prog +
(-} Arguivos de Prog
[+ | c6004e65bca707
------ I d9af7elbcfadave
& L dell
-k Drivers
------ | e7668baec705dc| |
- L. HP Universal Prin -
- | jbrj-images 00386871.CR2 01094291.CR2
...... ) batch
------ | camera

| duplicates
E- | incoming
Loisl
output
output_11032
output_11122
output_15012
output_15012
output_15012
output_17122
output_ 17122
output_18032
output_23032
output_26022
session

T e O e O o O O O e O O OO e O
- G- - - e - - - - - B

Figura 20. Pasta “Session” no Digital Photo Professional.
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Py =
[ [E] Silverimage % \+

€ )l )@ | localhost/silverimage/index.php ¢ Q pq

E] SilverImage E] Silverlmage Manager EE Tropicos & Gmail ﬁ jabot &l fsi @ HV

File = ] Reports &) Help~

Warning
Project: default More than one image in queue.
Barcode Entry: Scanner Mode Session History Issues Force Upload

| Scanner Mode ~ | Post Fix |\—:J Auto Refresh

Station D Filename
Barcode: ‘ ‘

1 00384243.CR2

i - 1 00386871-2.CR2
IMG_0011.CR2 ® 1 00386871-1.CR2
1 00386871.CR2

Last Barcode Scanned 1 01094291.CR2
1 01032455-1.CR2

00384243 1 00112233.CR2
Statistics 1 01028281-1.CR2
1 01049887-1.CR2

1 N1N1KR18A 1 CR"

Figura 21. SilverImage: mensagem que aparece quando mais de uma imagem estdo na pasta

“Incoming”.



[F Silvermage +
\
€ | localhost/silverimage/index.php
[Z] silverimage [Z] Silverimage Manager [ Tropicos & Gmail Ji jabot Gl fsi @ HV.
File v Reports Help~
Project: default
Barcode Entry: Scanner Mode Session | History || Issues || Force Upload
Scanner Mode ~ | Post Fix Auto Refresh
T Station|D  Filename
1 00386871.CR2
IMG_0006.CR2 1 01094291.CR2
1 01032455-1.CR2
Last Barcode Scanned
1 00112233.CR2
00386871 1 01028281-1. CR2
1 01049887-1.CR2
Statistics
1 01018185-1.CR2
1 00960909-1.CR2
Confirm x
© | Specimen image exists. Are you sure you wish to overwrite 00386871.CR2 that is at stage
-:/ SESSION and located at C:/jbrj-images/session/?
Yes No
1 00769134.CR2
1 00769100.CR2

Figura 22. Mensagem avisando que a imagem ja foi renomeada/fotografada, esta salva na

pasta apontada e se deseja substitui-la pela imagem recém-tirada.

Digitacdo do cddigo de barras (Manual Mode)

Caso ndo esteja utilizando cédigo de barras (ou esse estiver ilegivel, mal impresso, apagado
etc), clique no botdo “Scanner mode”, localizado acima do campo Barcode, e ele mudara para
“Manual mode” (Fig. 23), digite o cddigo e aperte “Enter”. O programa sinalizard com uma
mensagem que a imagem foi salva com sucesso e entdo a barra verde desaparecerd
automaticamente. (Muita atencdo na hora de digitar o cédigo corretamente!)

Obs. 1: Caso digite o niUmero errado e salve por engano, clique no botdo “Auto Refresh” (Fig.
24, lado direito do Silverimage) e em seguida clique com o botdo direito do mouse na imagem
gue pretende corrigir (Aten¢do! Sempre clique no Auto-Refresh antes de clicar na imagem! O
programa ira reclamar e pedir para que ative o Auto-Refresh se tentar clicar direto sobre a
imagem com o botdo direito do mouse). Irdo aparecer duas op¢des “Rename ou Remove”.
Selecione “Rename” e digite novamente o niumero correto.

Obs. 2.: Caso queira renomear uma imagem que foi lida pelo scanner (leitor de cédigos) com o
cédigo errado, proceda da mesma forma porém renomeie com auxilio do leitor ao invés de

digitar manualmente.
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/ Silvermage x \ +
L/

€ il localhost/silverimage/index.php
D Silverlmage D Silverlmage Manager EE Tropicos & Gmail w
File » J Reports &) Help »
Project: default
Barcode Entry: Manual Mode

. Manual Mode vl Post Fix

Barcode: “

Last Barcode Scanned

00384243

Figura 23. Botdo “Manual Mode”/”Scanner Mode” no Silverimage.
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/ EI Silverimage x \ +
=

@ ] localhost/silverimage/index.php
D SilverImage D SilverImage Manager E Tropicos & Gmail ‘—,:,;jabot fsi @ HV
Filew |= Reports &) Help~
Project: default
Barcode Entry: Scanner Mode Session History || Issues Force Upload

Scanner Mode ~ | Post Fix o Auto Refresh

Station D Filename
1 00:
01

Barcode:

i) Rename Specimen Sheet
Last Barcode Scanned 1

1 010 |&4 Remove Specimen Sheet

00386871 1 00112233.CR2

isti 1

01028281-1.CR2

Figura 24. Botdo “Auto-Refresh” deve ser acionado antes de clicar sobre a imagem para

“Remover” ou “Renomear”.

Exsicatas com mais de uma prancha

Para salvar outras partes de uma mesma exsicata (quando houver mais de uma prancha):
fotografar e salvar normalmente a exsicata principal, e, a partir da segunda clicar no botdo
PostFix no Silverimage (Fig. 25, acima do campo Barcode), fotografar e salvar normalmente
quantas forem as camisas. Esse botdo numerara as demais pranchas com o mesmo cédigo de
barras e estas serdo salvas desse modo: ABC00056978, ABC00056978 1, ABC00056978 2 etc.
Desative o PostFix em seguida. (Este processo requer muita atencdo! Caso ndo desative o

PostFix o SilverImage continuara numerando as préximas exsicatas!)



/ [E] silverimage x |\ +
¥ g

€ i localhost/silverimage/index.php
D SilverImage D Silverimage Manager E;; Tropicos & Gmail ﬁ jabot &l fsi @ HV
File = ] Reports &) Help~

Project: default

Barcode Entry: Scanner Mode Session History
Scanner Mode + ‘Pust Fix|| Numerical = “:—' Auto Refresh |
Barcode: “ | 1 c StationID  Filename
1 00386871.7
1 01032455-1
Last Barcode Scanned
1 00112233.
00386871 1 01028281-1
1 01049887-1
Statistics
1 01018185-1
1

00960909-1

Figura 25. Botdo “Post-fix” para numerar demais camisas das exsicatas com o mesmo cédigo

de barras.

PASSO 7 - EXCLUSAO DE FOTOS

Caso queira apagar a foto e refazer, clique no ‘X’ da barra verde do Silverlmage. Ird aparecer

uma mensagem confirmando a exclusdo. Clique em “yes” e a imagem serd excluida (Fig. 26).

Obs.: Essa é a forma mais recomendada de exclusao das fotos. Existem duas outras formas de
excluir: a primeira é clicando diretamente (com o botdo direito do mouse) na imagem listada
na parte direita do Silverimage (Fig. 24), obedecendo o comando de ativar o Auto-Refresh
antes, e selecionando “Remove”; a segunda é através do Digital Photo Professional, clicando

com o bot3do direito do mouse sobre a imagem e selecionando “Delete” (Fig. 27).
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/ Silverimage x- +
)

(- B () localhost/silver mage/index.php o Q_ Pesquisar
E] SilverImage E] SilverImage Manager E Tropicos & Gmail %jabm =l fsi :Q HV
File» Reports Help ~

Project: default

Barcode Entry: Scanner Mode Session History Issues Force Upload
Scanner Mode ~ | Post Fix Auto Refresh

ot StationID  Filename
1 00384243 CR2
1 00386871-1.CR2

Last Barcode Scanned
1 00386871.CR2

00384243 1 01094291 CR2

1 01032455-1.CR2

Statistics
1 00112233.CR2
1 01028281-1.CR2
1 0104 Remove Camera Image X
! 0101 < |, Are you sure you wish to remove IMG_0011.CR2 camera

1 0096 image?
1 0057
Yes No
1 0077
1 00769231.CR2

Figura 26. Para excluir a imagem clicar no “X” no canto da barra verde e em seguida “Yes” na

mensagem.
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com o botdo direiro do mouse em “Delete”.



PASSO 8 — CORREGCAO DA DISTORCAO DA LENTE

Apds terminar de fotografar, desligar as luzes, tampar a lente e desligar a camera.
Na Area de Trabalho, abrir o Digital Photo Professional na pasta Session, selecionar todas as
imagens fotografadas (clicar em Select all), clicar em “Tool palette” e nessa nova janela clicar
na aba “Lens” (Fig. 28). Em seguida, clicar no botdo “Tune” e fazer os seguintes ajustes (Fig.
29):

- mover a barra “Shooting distance information” para o primeiro 1/3 da barra;

- habilitar o “Distortion” e verificar se esta em “100”;

- clicar em OK.
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Figura 29. Ajustes da lente no Tool Palette.

PASSO 9 — TRIMMING (CORTE DAS IMAGENS)

Apds corrigir a distorcdo da lente, selecionar todas as imagens (Select all) e clicar em

“Trimming Angle” (Fig. 30 e 31).

- Cortar a margem da primeira imagem (clicar e arrastar um retangulo), em seguida clicar em
“Copy”, “Apply all” e “yes” na janela que aparecera perguntando se deseja aplicar esse corte

em todas as imagens. Assim, todas as imagens terdo o mesmo corte.

- Para visualizar como a imagem ficara apds o corte é s correr a barra de “Opacidade” (Fig. 31)

para os lados. (Sempre deixe a barra de Opacidade no meio para visualizar as partes cortadas!)

- Em seguida, clicar em “Next” para prosseguir para a préxima imagem e realizar as correc¢oes
necessarias. Proceder clicando em “Next” e ajustando as margens até chegar a ultima foto.

Clicar em “OK” no canto inferior esquerdo da janela. (Cuidado para ndo clicar em “Cancel”!)

Obs.: Se o corte de uma foto for similar ao da préoxima, pode-se clicar em “Copy” (ou “Ctrl c”
no teclado) e depois em “Paste” (ou “Ctrl v”’) na imagem com formato similar e utilizar essa

ferramenta para facilitar o trimming.



Obs. 2: NUNCA faca o trimming com pressa! E nesse momento que o bolsista ira analisar com
calma foto por foto (foco, luz, escalas, etiquetas etc) e verificar tudo o que ja foi feito no dia!
E muito recomendédvel que uma segunda pessoa reveja o trimming apds seu término.
Lembre-se: esse é o formato FINAL e DEFINITIVO da imagem que sera disponibilizada no

Herbario Virtual!
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Figura 30. Digital Photo Professional. Na pasta Session, clicar em “Select All” e depois em

“Trimming Angle” para iniciar o trimming.
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Figura 31. Janela do “Trimming”.

PASSO 10 — BATCH PROCESS: processando CR2 em JPG

Terminado o processo de Trimming, verificar se todas as imagens ainda estdo selecionadas na
pasta “Session” no Digital Photo Professional e clicar em “Batch process” (Fig. 32).

Obs. 1: Verificar as configuracdes do Batch Process: selecionar a pasta “Session” no campo
“Save Folder”; selecionar “Exif-JPEG” em “File format”; selecionar “350 dpi” em “Output
resolution” e “Current File Name” em “File Name”.

Obs. 2: Espécimes Typus: Para espécimes Typus, a configuragdo do Batch Process devera ser
alterada para TIFF 16bits, 600dpi. O restante do processo (foto, Trimming, Batch Process etc) é
igual ao realizado para os materiais “comuns”.

Clicar em “Execute”. Ird aparecer uma janela que iniciard o processamento das imagens

(conversao dos formatos CR2 para JPG) (Fig. 33).
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Figura 32. “Batch Process”. Checar configuracGes e “executar”.
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PASSO 11 — FINALIZE SESSION
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1. Apds o “Batch process”, a pasta Session passara a conter dois formatos de cada arquivo

(CR2 e JPEG) (Fig. 34). Esse processo pode ser rapido ou demorado, dependendo da

quantidade de material que foi fotografado. A conversdao de CR2 para JPEG demora cerca

de 7seg. para cada imagem.
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Figura 34. Pasta “Session” com imagens CR2 ja processadas em JPG.

2. Ao entrar novamente no Silverlmage para iniciar um novo turno é necessario esvaziar a

pasta Session e enviar as imagens para a pasta Output, onde estas ficardo armazenadas.
Para isso, entre com o seu login no Silverimage, clique na aba “Finalize session” e depois
em “File images” e deixe processar (geralmente é rapido) (Fig. 35). Apds o processamento,
pode-se iniciar uma nova sessdo de fotos (voltar para a aba Session no Silverimage).
IMPORTANTE: Apds o término do “Finalize Session”, a pasta Session deve estar vazia para
comecar uma nova sessao de fotos. Se ndo estiver vazia, verificar se foi feito o Tool Palette
e Trimming, ou seja, se foi feita a edicdo das imagens, e se foi executado o BatchProcess,
ou seja, se existem os dois formatos salvos para cada arquivo (CR2 e JPEG). S6 inicie uma
nova sessdo de fotos se a Session estiver vazia! Sendo ira acumular fotos da sessdo
passada com o atual e pode gerar confusao.

Obs.: Todo o material fotografado, apds finalizar a sessao (Finalize Session) e fazer o “File

images” deverd estar armazenado na pasta C:\HERBARIO images\output.
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Figura 35. Abra a aba “Finalize Session” e clique em “File Images”.



PASSO 12 - OUTPUT

Na pasta “output” os arquivos estardo salvos em subpastas, uma dentro da outra, cada uma
com dois digitos do cédigo associado a imagem. Por exemplo, para localizar o cédigo de barras
00060764 deve-se entrar nas seguintes pastas: pasta 0 (=00), pasta 6 (=06), pasta 7 (=07) e

pasta 64. Dentro desta ultima (64) estardo os arquivos nos dois formatos, CR2 e JPEG (Fig. 36).
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Figura 36. Organizacdo das pastas dentro da pasta “Output”.

PASSO 13 — FINALIZANDO O TRABALHO DE DIGITALIZAGAO

No final do turno de trabalho, o bolsista responsavel pela Estacdo deverd: limpar o local de
trabalho, guardar os materiais utilizados (pinga, pincel etc), desligar a cdmera, tampar a lente,
cobrir a cdmera com um pano, apagar as luzes da estacdo e desligar o monitor. Nunca desligar
o computador, pois os arquivos CR2 podem estar sendo convertidos em JPG!

Guardar o material fotografado nos devidos armdrios e marcar o lugar onde parou.

PASSO 14 — ENVIO DE IMAGENS PARA O HERBARIO VIRTUAL

Ao final de cada més, renomear a pasta output acrescentando o nimero do més em que
foram feitas as imagens e o ano (Ex. output_062016). Depois desta modificacdo, criar uma
nova pasta “output” para que o programa possa armazenar as novas imagens que serao
feitas no més seguinte.

Atencdo! Se houver erro na grafia da pasta “output” as imagens podem ser perdidas no
momento que for realizado o “File Images”!

A pasta renomeada (Ex. output_062016) é a pasta que deverd ser gravada no HD externo,
servidor ou outra forma de backup.

Somente as imagens JPG serdo enviadas para o Herbario Virtual. Para filtra-las abra a pasta

“output_mésANO” no Windows Explorer e digite “jpg” no campo de busca no canto superior



direito (onde tem uma lupa). Irdo aparecer todas as imagens JPG dessa pasta. Copie e cole
para uma nova pasta (Ex. “output_mésANO_jpg”). Essa sera a pasta que devera ser enviada
para o Herbario Virtual.

Para enviar as imagens ao JBRJ, baixe um programa de acesso a FTP (o JBRJ utiliza o Filezilla,
gratuito e disponivel para download no link https://filezilla-

project.org/download.php?show all=1).

Preencha o campo “Host” com a seguinte informagao: imagensl.jbrj.gov.br. Os campos
“Nome do usudrio” e “Senha” deverdo ser preenchidos com as informag¢bes que serdo
enviadas por email pelo JBRJ.

Apds conectar ao servidor, carregue a pasta com as imagens (Ex. output_mésANO_jpg) para
este programa.

Os dados relativos as imagens deverdo ser enviados no formato padrdo fornecidos pelo JBRJ

(planilha Excel).

Gerenciamento das exsicatas

Ha a possibilidade de encontrar exsicatas com partes da planta soltas, descoladas ou
descosturadas. O bolsista tem autonomia de montar este material solto e colar envelopes
para guardar partes frageis do material. O supervisor deve ajudar nesta etapa para otimizar o
trabalho. O material para montagem (adesivo, esponja, cola, tesoura e envelopes) devera

estar disponivel nas estagdes.

Sempre abra os envelopes de modo a exibir seu conteddo, quando estes possuirem

fragmentos importantes como flores, frutos etc.
Sempre manipular o material com muito cuidado para ndo danifica-lo!

Materiais contaminados por parasitas ndo sdo fotografados. S3o separados do acervo e

levados para descontaminagdo. Informe sempre ao supervisor ou a curadoria nesses casos.
O material deverd sempre ser informatizado antes de ser fotografado.

Verificar se na camisa do material principal e dos adicionais consta o nimero de tombo ou

cddigo de barras, caso contrdrio acrescente este nimero a caneta.

E importante que haja alguma marcacdo nas exsicatas que informe que tais materiais ja foram

fotografados facilitando a consulta e evitando problemas futuros.



e Verifique se as partes vegetativas e reprodutivas estdo aparentes na exsicata conforme ela
foi montada (sem estarem encobertas por envelopes, etiquetas ou outros itens que
possam obstruir a visibilidade de partes importantes do material). Neste caso, avalie a
possibilidade do material ser remontado! Lembre-se: A sua fotografia trara beneficios ndo

so para o seu herbario, mas para toda a comunidade cientifica!
Problemas recorrentes

e A pagina do Silverlmage no Mozilla Firefox ndo carrega e aparece a mensagem de erro de
gue ndo foi possivel a conexdao com o “Localhost 300”. Verifique se o icone verde do
servidor (janela de comandos com fundo preto) esta ativo no rodapé da area de trabalho.
Caso ndo esteja é necessdrio ativa-lo (duplo clique no icone do Siverlmage com as
engrenagens que esta na area de trabalho) primeiramente.

e Pode acontecer de sobrar imagens em JPEG na pasta session mesmo depois de fazer o
Finalize Session, ou seja, a imagem ndo foi enviada junto a original (CR2) para a pasta
output. O procedimento deve ser recortar a imagem JPEG existente na pasta session e
cola-la na pasta output correspondente a imagem original em RAW (CR2).

e Pode acontecer de sobrar imagens CR2 na pasta session. Verifique se essas ja estdao
editadas (correcdo da lente e trimming) e faca a conversio em JPG novamente
(BatchProcess).

e Ao fotografar uma exsicata e o programa informar que ja existe uma imagem com o mesmo
cédigo e se quer substituir a imagem, clicar em ‘ndo’. Buscar nas pastas do output ou
session a imagem com o mesmo cddigo e verificar se esta contém as mesmas informacoes
e se é a mesma coleta daquela que estad sendo fotografada. Caso sim, substitua ou ndo a
imagem (veja qual exsicata estd mais adequada) e junte as exsicatas. Caso ndo, busque qual
delas tem o numero de tombo mais antigo nos livros de registro e dé um novo nimero de
tombo e/ou novo cddigo de barras para a exsicata com numero de tombo errado. Se a
imagem que ja estd arquivada tiver as informacGes erradas, apague, informatize
corretamente e fotografe novamente.

e O BatchProcess ndo executa e aparece uma mensagem “Identically named files exists.
Cannot execute batch.” Recorte as imagens CR2 e cole em uma nova pasta na Area de
Trabalho. No DigitalPhotoProfessional selecione a nova pasta (na barra a esquerda) e clique
em “Batch Process”. Na janela do BatchProcess mude a pasta do “Save folder” para a nova

pasta criada. Clique em “Execute”.
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ROTINA PARA DIGITALIZAGAO

Ativar camera e programas

19 Ligar equipamentos (Luzes, cdmera, tirar tampa da lente).
20 Abrir o programa EOS Utility e clicar no Camera Settings.
30 Abrir o Silverlmage da area de trabalho (engrenagens).

Abrir o Mozilla e clicar no Silverimage (barra de favoritos). Fazer login. Clicar: File, Open
40 Project e Projeto. Abrird o programa (aba Session).

Observar no Digital Photo se a pasta SESSION esta vazia. Se sim, continuar, se ndo, quer
dizer que ainda existem imagens sem correc¢do de lente e/ou cortadas e/ou n3o estd
convertidas em JPG. Desta forma, deve-se observar o que esta faltando e pular para o passo
59 coerente a situagdo (passo 129).

Digitalizagao e leitura do cédigo de barras

62 Tirar a foto.

Verificar qualidade. Se preciso, abrir imagem no Digital Photo (pasta incoming) e dar zoom.
79 Fechar imagem.
89 Voltar para o Silverlmage e passar o cddigo de barras no leitor (Barcode).

Imagem serd renomeada com o cédigo de barras (saira da pasta incoming para a session no
99 Digital Photo)

102 | Para digitalizar mais plantas, voltar ao passo 62.

Ao terminar de digitalizar as fotos do dia, desligar as luzes, cdmera e colocar a tampa na
112 |lente.

Edi¢cdo das imagens (Digital Photo)

Corrigir a distorgao da lente: Clicar em Select All e Tool Pallet. Abrird uma janelinha. Clicar
na aba Lens. Clicar em Tune. Deslocar a barra Shotting Distance p/ mais ou menos 1/3.
122 | Selecionar "Distortion" (100). Clicar OK.

Cortar imagens: Clicar em Select All e Trimming Angle. Ajustar o retangulo e verificar se nao
estd cortando nenhuma informacao. Clicar em Copy, depois Apply All e OK. Para o corte da
132 | préoxima imagem clicar em Next. Ajustar e clicar em Next até acabar. Clicar em OK.

Conversao em JPG

Clicar em Select All, depois Batch Process e Executar. Abrird a janela de conversao. Este
processo é demorado. Apds a conversao conferir se o numero de fotos convertidas é igual
132 | ao dobro de fotos tiradas (CR2+JPG).

Finalizagdo da sessdo (No Digital Photo = mover imagens da Session para o Output)

Entrar no Silverlmage (login, File etc). Clicar na aba Finalize Session e no botao File Images.
Verificar se o numero "uploaded" é igual ao nimero de fotos tiradas. No Digital Photo
142 | verificar se a pasta session esta vazia.

Para comegar novamente a digitalizagdo, deve-se retornar ao 52 passo, se caso estiver tudo
152 | configurado

Pastas do programa Digital Photo:
Pasta incoming: | A foto recém-tirada (com nome da camera IMG_0001).
Fotos ja renomeadas com cddigo de barras no Silverimage
Pasta session: | (ABCO00001).
Pasta output | Onde as fotos finalizadas ficardo armazenadas (CR2+JPG).




